
Chapter 2

Creating Axle and 
Disc Plate

 Learning Objectives  
After completing this chapter, you will be able to:
• Use the Extruded Boss/Base tool.
• Invoke the Sketching environment.
• Use the Circle tool.
• Apply diameter dimensions by using the Smart Dimension tool.
• Apply cosmetic threads with shaded display.
• Create polygons using the Polygon tool.
• Use the Convert Entities tool.
• Use the Offset Entities tool.
• Create centerlines using the Centerline tool.
• Create a line using the Line tool.
• Create the mirror image of sketching entities.
• Trim unwanted entities from a sketch.
• Create a circular pattern.
• Create a fi ll pattern.
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CREATING THE FRONT AXLE
 Part Description 
In this section, you will create the front axle, as shown in Figure 2-1. The features of this Axle 
will be created by using the Extruded Boss/Base tool. The cosmetic threads with shaded 
display to be created are of Ansi Inch Machine Threads type. The views and dimensions of 
the axle are given in Figure 2-2. Note that all dimensions are in inches. 
        

Figure 2-1  Front axle

Figure 2-2  Views and dimensions of the front axle

Starting SolidWorks and then a New Part Document
 Once you have installed SolidWorks, an icon is displayed on the desktop and a folder is 

added to the Start menu.

1. Start SolidWorks by choosing Start > All Programs > SolidWorks 2011 > SolidWorks 
2011 or by double-clicking on the shortcut icon of SolidWorks 2011 displayed on the 
desktop of your computer; the SolidWorks window is displayed on the screen. Also, the 
SolidWorks Resources task pane is displayed on the right, as shown in Figure 2-3. This 
window can be used to open a new fi le or an existing fi le. 
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Figure 2-3  The SolidWorks 2011 window and the SolidWorks Resources task pane

If the SolidWorks Resources task pane is not displayed by default, choose the SolidWorks 
Resources button to display it. This window is used to open online tutorials and to visit the 
SolidWorks’ partner website.

2. In the Getting Started area of the SolidWorks Resources task pane, choose the New 
Document option to start a new fi le. Alternatively, choose the New button from the Menu 
Bar; the New SolidWorks Document dialog box is displayed, as shown in Figure 2-4. 

      

Figure 2-4  The New SolidWorks Document dialog box E
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3. In the New SolidWorks Document dialog box, the Part button is chosen by default. 
Choose the OK button; a new SolidWorks part document gets started. Modify the unit of 
the current document to inch, if it is not set by default.

Note
As it is already mentioned in the part description that all dimensions are in inches. Therefore, 
you may need to modify the units used in the current session to inches. To do so, choose the 
Options button from the Menu Bar; the System Options dialog box is displayed. Next, choose 
the Document Properties tab. In this tab, select the Units option from the area on the left 
of the dialog box to display the options related to it. The default unit system that was selected 
while installing SolidWorks is selected in the Unit system area of the dialog box. Select the 
IPS (inch, pound, second) radio button from the Unit system area and then choose the OK 
button from the dialog box.

After starting a new SolidWorks part document, you can create the model of Axle by using 
different feature creation tools of SolidWorks. 

Creating the Base Feature of the Axle
 Most of the products designed by using SolidWorks are the combinations of the sketched, 

placed, and derived features. The base feature is a feature that is created fi rst to make 
a model in the Part environment. The placed and derived features are created without 
drawing sketches, whereas the sketched features require a sketch to be drawn fi rst. Generally, 
the base feature of any design is a sketched feature and is created using a sketch. Therefore, 
while creating any model, the fi rst and foremost task is to draw a sketch for the base 
feature. Once you have drawn the sketch, you can convert it into a base feature and then 
add other sketched, placed, and derived features to it to complete the model.

 In this section, the base feature will be created by extruding a sketch using the Extruded 
Boss/Base tool available in the Features CommandManager. This tool is used to add 
material to the area defi ned by a sketch. To create the base feature, fi rst you need to draw 
the sketch of the base feature in the sketching environment using the tools available in 
the Sketch CommandManager. After drawing the sketch, you can extrude it using the 
Extruded Boss/Base tool. 

1. Choose the Features tab from the CommandManager to display the Features 
CommandManager, refer to Figure 2-5.

2. Choose the Extruded Boss/
Base tool from the Features 
CommandManager; the Extrude 
PropertyManager is displayed 
on the left in the drawing area, 
see Figure 2-6. Also, three default planes 
are displayed at the center of the drawing 
area and you are prompted to select the 
sketching plane.

Figure 2-5  The Features CommandManager
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The default planes are called datum planes and 
are used to draw 2D sketches. These 2D sketches 
can be further converted into 3D models by 
extrusion. The datum planes are mutually 
perpendicular to each other. You can select any 
of these datum planes as a sketching plane. The 
sketching plane is a plane on which the sketch of 
the feature will be drawn. You can also create a 
plane other than the default planes by using the 
Plane PropertyManager. You will learn more 
about the Plane PropertyManager in the later chapters.

3. Next, select the Front Plane as the sketching plane in the drawing area; the sketching 
environment is invoked and the selected plane is oriented normal to the view. By 
default, there are two arrows at the origin that indicate the X and Y axis directions of the 
current sketching plane. Also, a confi rmation corner is displayed with the Exit Sketch 
and Cancel Sketch options at the upper right corner of the drawing area, refer to 
Figure 2-7.

           

Figure 2-7  The screen display in the sketching environment

4. In the Sketch CommandManager, choose the Circle button; the Circle 
PropertyManager is displayed on the left in the drawing area, as shown in 
Figure 2-8. Also, the cursor is replaced by the circle cursor.

In the Circle PropertyManager, the Circle button is chosen by default in the Circle Type 
rollout. As a result, you can draw a circle by specifying its center and radius. 

Figure 2-6  The Extrude PropertyManager
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5. Move the circle cursor toward the origin and click when the orange circle and the symbol 
of coincident relation are displayed; the center point of the circle is specifi ed. You will 
learn more about relations later in this chapter. As soon as you specify the center point of 
the circle, the dynamic preview of the circle is displayed on the screen.

The origin of the sketching environment screen is represented by a red colored point at the 
center of the screen. The coordinates of this point are 0,0. You can hide or display the origin 
by choosing the View Origins button from the Hide/Show Items fl yout in the View (Heads-up) 
toolbar, refer to Figure 2-9.

Figure 2-9  The Hide/Show Items fl youtFigure 2-8  The Circle PropertyManager

 After specifying the center point of the circle, if you move the cursor to defi ne its radius, 
the current radius of the circle is displayed above the circle cursor. This radius changes 
as you move the circle cursor. To specify the radius of the circle, you need to click in the 
drawing area.

6. Move the circle cursor toward the right and click when 0.375 is displayed above the circle 
cursor. 

Tip. After specifying the center point and radius of the circle, you can modify their 
parameters in the Parameters rollout of the Circle PropertyManager.  

Note
If a sketch is displayed in blue, it indicates that the sketch is underdefi ned. An underdefi ned 
sketch is the one in which some of the dimensions or relations are not defi ned and the degrees of 
freedom of the sketch are not fully constrained. In these types of sketches, the entities may move 
or change their size unexpectedly. The sketched entities of the underdefi ned sketch are displayed 
in blue. In SolidWorks, there are six states in which a sketch may exist. These states are fully 
defi ned, overdefi ned, underdefi ned, dangling, no solution found, and invalid solution found. 

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om



Creating Axle and Disc Plate                   2-7 

Tip. The Sketch Defi nition area of the status bar, which is located at the bottom of the 
drawing window, always displays the status of the sketch, dimension of the sketch, and its 
relation. If the sketch is underdefi ned, the status area will display Under Defi ned; if the 
sketch is overdefi ned, the status area will display Over Defi ned; and if the sketch is fully 
defi ned, the message displayed in the status area will be Fully Defi ned. 

 After drawing the sketch, dimensioning is the most important step for creating a design. 
SolidWorks is a parametric software. This property of SolidWorks ensures that irrespective 
of the original size, the selected entity is driven by the specifi ed dimension value. Therefore, 
when you apply dimension to an entity or modify it, the sketch is forced to change its size 
in accordance with the specifi ed dimension value.

7. Choose the Smart Dimension button from the Sketch CommandManager 
to dimension the circle; the cursor gets converted into the dimension cursor. 
Select the circle; the current diameter of the circle is attached to the cursor. 
Specify location in the drawing area for placing the diameter of the circle. As As 
soon as you place the diameter, the soon as you place the diameter, the ModifyModify dialog box is displayed, as shown  dialog box is displayed, as shown 
in Figure 2-10.in Figure 2-10.

     

Figure 2-10  The Modify dialog box

  

The Smart Dimension tool is used to dimension any kind of entity. If you use this tool, the 
type of dimension applied will depend on the type of entity selected. 

The Modify dialog box is used to modify the default dimension values. In this dialog box, you 
can either use the spinner or enter a new value in the edit box. You can also change the value 
by dragging the thumbwheel located below the spinner to left or right, as required.  

Figure 2-11  Circle of diameter 0.75in

8. In this dialog box, enter 0.75 and choose the Save 
the current value and exit the dialog button from 
this dialog box. Figure 2-11 shows a circle of diameter 
0.75 inch. 

    
Note
After applying the diameter dimension to the sketch, 
the blue colored sketch changes to black. This indicates 
that the sketch is now fully defi ned. 
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A fully-defi ned sketch is the one in which all entities of the sketch and their positions are 
fully-defi ned by the relations or dimensions, or both. In a fully-defi ned sketch, all degrees 
of freedom of a sketch are constrained. As a result, the sketched entities cannot change their 
size and location unexpectedly. If a sketch is not fully-defi ned, its size or position can change 
at any time during the design because all its degrees of freedom are not fully constrained. All 
entities in a fully-defi ned sketch are displayed in black.

9. Next, exit the sketching environment by clicking on the confi rmation corner 
available on the upper right corner of the drawing area; the Boss-Extrude 
PropertyManager is displayed on the left in the drawing area, refer to Figure 2-12. 
You will notice that the default view is automatically changed to the trimetric view and the 
preview of the base feature is displayed on the screen. Also, a 3D arrow will be displayed 
in the preview, as shown in Figure 2-13.

Figure 2-13  Preview of the base feature 
with arrow

Figure 2-12  The Boss-Extrude 
PropertyManager

The Direction 1 and Direction 2 rollouts in the Boss-Extrude PropertyManager are used 
to specify the end conditions for extruding the sketch in the fi rst and second directions, 
respectively. The Direction 1 rollout is expanded by default and to expand the Direction 2 
rollout, you need to select the check box available on the title bar of the rollout. The options 
in these rollouts are same. You will learn more about these options later.
 
10. Select the Mid Plane option from the End Condition drop-down list of the Direction 1 

rollout in the Boss-Extrude PropertyManager.

Tip. You can also choose the Mid Plane option from the shortcut menu displayed on 
right-clicking in the graphics window when the Boss-Extrude PropertyManager is 
active.
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The End Condition drop-down list is used to defi ne the termination condition of an extruded 
feature. The Mid Plane option of this drop-down list is used to create the feature by extruding 
a sketch equally in both the directions of the plane on which the sketch is drawn. Note that 
when you create the fi rst feature, some of the options of this drop-down list will not be available. 
The other options available in this drop-down list will be discussed later in this chapter.  

11. To specify the depth of extrusion, set 8” in the Depth spinner of the Direction 1 
rollout.

Tip. You can also specify the depth of extrusion by dragging the arrow displayed on the 
preview of the model. 

12. Choose the OK button ( ) from the Boss-Extrude PropertyManager to exit.

13. Choose the Zoom to Fit button from the View (Heads-up) toolbar to fi t the feature 
into the screen. 

The Zoom to Fit tool is used to increase or decrease the drawing display area so that all entities 
are properly fi t in the current view. You can also invoke this tool by pressing the F key or by 
double-clicking on the middle mouse button in the drawing area.

14. Choose the View Orientation button from the 
View (Heads-up) toolbar; the View Orientation 
fl yout is displayed, as shown in Figure 2-14.

15. Choose the Isometric button from this fl yout; 
the current orientation of the model changes 
to isometric. The model after creating the base 
feature is shown in Figure 2-15.

In SolidWorks, you can change the view orientation manually by using some predefi ned 
standard views or user-defi ned views. The views available in the View Orientation fl yout are 
called standard views. You will learn more about the user-defi ned views and the standard 
views in later chapters.
    

Figure 2-15  Base feature of the model

Figure 2-14  The View Orientation fl yout
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Creating the Second Feature
 The second feature of this model is also an extrude feature. This feature will be created 

by using the Extruded Boss/Base tool available in the Features CommandManager. The 
sketch of this extrude feature needs to be created on the front planar circular face of the 
base feature.

 
1. Choose the Extruded Boss/Base button from the Features CommandManager; 

the Extrude PropertyManager is displayed on the left in the drawing area and 
you are prompted to select the sketching plane.

2. Select the front planar circular face of the base feature as the sketching plane, refer to 
Figure 2-16; the sketching environment is invoked.

    

Figure 2-16  Face to be selected

 Next, you need to change the current orientation of the feature normal to the screen.

3. Choose the Normal To button from the View Orientation fl yout in the View 
(Head-up) toolbar; the current orientation changes to normal. 

The Normal To tool is used to reorient the view normal to a selected face or plane.

4. Choose the Polygon tool from the Sketch CommandManager; the Polygon 
PropertyManager is displayed on the left in the drawing area and the cursor 
changes into a polygon cursor. Make sure the value in the Number of Sides spinner 
is set to 6 and the Inscribed circle radio button is selected in the Parameters rollout of 
the PropertyManager. 

The Polygon tool is used to draw a regular polygon. A regular polygon is defi ned as a multisided 
geometric fi gure in which the length of all sides and the angle between them are the same. In 
SolidWorks, you can draw a regular polygon with the number of sides ranging from 3 to 40. 
The dimensions of the polygon are controlled by using the diameter of a construction circle 
that is either inscribed in a polygon or circumscribes it. If the Inscribed circle radio button 
is selected in the Parameters rollout, the construction circle will be inscribed in the polygon 
and the diameters of the construction circle will be determined by the edges of the polygon. 
However, if the Circumscribed circle radio button is selected in the Parameters rollout, the 
construction circle will circumscribe around the polygon and the diameters of the construction 
circle will be determined by the vertices of the polygon. 
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Figure 2-17  Symbol of coincident relation

5. Move the polygon cursor toward the center 
of the circular face of the base feature and 
click to specify a point when the origin gets 
highlighted and the symbol of coincident 
relation is displayed below the polygon cursor, 
refer to Figure 2-17. 

6. Next, move the circle cursor vertically upward 
and click when the preview of the polygon 
crosses the circular edge of the base feature. 
Next, press the ESC key.

7. Choose the Smart Dimension button from the Sketch CommandManager; 
the cursor modifi es into a dimension cursor. Select the construction circle that 
is inscribed in the polygon; the current diameter of the construction circle is 
attached to the cursor. In the drawing area, specify the location to place the 
diameter of the construction circle. As soon as you place the diameter, the As soon as you place the diameter, the ModifyModify dialog  dialog 
box is displayed.box is displayed.

8. Enter 1 in the Modify dialog box and choose the Save the current value and exit the 
dialog button. Next, press the ESC key to exit the Smart Dimension tool. 

Figure 2-18  Pop-up toolbar

9. Select a vertical edge of the polygon and do not move 
the mouse; a pop-up toolbar is displayed, as shown in 
Figure 2-18. 

Note
The options in the pop-up toolbar will vary based on the entity 
or feature selected. Also, the toolbar will disappear if you move the cursor away from the selected 
entity or feature.

Figure 2-19  Fully-defi ned sketch

10. Choose the Make Vertical option from the 
pop-up toolbar, refer to Figure 2-18; the vertical 
relation is applied to the selected entity and 
the color of the sketch is changed to black, 
indicating that the sketch is now fully-defi ned, 
refer to Figure 2-19. 

The vertical relation is used to force one or more 
selected lines or centerlines to become vertical. You 
can also force two or more points to become vertical 
by using this relation.

Note
Figure 2-19 shows all the relations applied to the sketch. You can hide these relations by choosing 
the View Sketch Relations button from the Hide/Show Items fl yout in the View (Heads-up) 
toolbar. This is a toggle button.
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11. Exit the sketching environment by clicking on  the confi rmation corner available 
at the upper right side of the drawing area; the Boss-Extrude PropertyManager 
is displayed. 

12. In the Direction 1 rollout of the Boss-Extrude PropertyManager, set the value of the Depth 
spinner to 0.5. Note that the Blind option is selected in the End Condition drop-down 
list by default, enabling you to enter the value of depth. 

The Blind option is used to defi ne the point of termination of an extruded base feature by 
specifying the depth of extrusion in the Depth spinner.

Figure 2-20  Isometric view of the model

13. Choose the OK button ( ) from the 
Boss-Extrude PropertyManager; the 
extrude feature is created. Next, change 
the current orientation of the model to 
isometric by choosing the Isometric 
button from the View Orientation fl yout. 
Figure 2-20 shows the isometric view of 
the model.

Applying Cosmetic Threads
 Cosmetic threads are the schematic 

representation of threads. It is evident 
from Figures 2-1 and 2-2 that cosmetic 
threads need to be applied to the model. 
You can apply the cosmetic threads by using the Cosmetic 
Thread PropertyManager.  

1. Choose Insert > Annotations > Cosmetic Thread 
from the SolidWorks menus; the Cosmetic Thread 
PropertyManager is displayed, as shown in Figure 2-21. 
Also, you are prompted to select the edges for starting 
the creation of threads and then set their parameters.

Note
You can create threads on a model as a solid feature. But it 
is recommended to create the cosmetic threads since the solid 
threads can be cumbersome to create and can signifi cantly 
slow down the performance of your computer. Also, since the 
cosmetic threads are as per industrial standards, there is no 
need to specify the thread profi les while creating them.

2. Select the circular edge of the model, refer to Figure 2-22. 
The name of the selected edge is displayed in the Circular 
Edges selection area of the Thread Settings rollout. Also, 
the schematic representation of the threads is displayed 
in the drawing area.

Figure 2-21  The Cosmetic 
Thread PropertyManagerE
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3. Select the Ansi Inch option from the Standard drop-down list in the Thread Settings 
rollout. 

The Standard drop-down list of the Cosmetic Thread PropertyManager is used to specify 
the industrial thread standards. In this drop-down list, the None option is selected by default. 
This allows the user to have user-defi ned specifi cation of the thread. The thread standards 
available in this drop-down list are Ansi Inch, Ansi Metric, AS, BSI, DIN, GB, IS, ISO, JIS, 
and KS.
    
4. Select the Machine Threads and 3/4-16 options from the Type and Size drop-down lists 

in the Thread Settings rollout, respectively.  

5. Select the Blind option from the End Condition drop-down list in the Thread Settings 
rollout of the Cosmetic Thread PropertyManager.

6. Set 0.5 in the Depth spinner.

7. Choose the OK button ( ) from the Cosmetic Thread PropertyManager; the cosmetic 
thread is added to the model. 

 Next, you need to display the cosmetic thread with shaded thread pattern on the 
surface.

 
8. Choose the Options button from the Menu Bar; the System Options - General dialog 

box is displayed. 

9. In this dialog box, choose the Document Properties tab; the System Option - General 
dialog box is replaced with the Document Properties - Drafting Standard dialog box.

10. Select the Detailing option from this dialog box; the corresponding options are displayed 
on the right of the dialog box. Select the Shaded cosmetic threads check box and then 
choose the OK button; the cosmetic thread is displayed in the drawing area with the shaded 
thread. Figure 2-23 shows the fi nal model after adding the shaded cosmetic threads. 

Figure 2-22  Circular edge to be selected Figure 2-23  Final model of Axle
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Saving the Model
 After creating the model, you need to save it at a particular location. It is recommended 

that you create a separate folder for saving all parts to be created in this book. When you 
invoke the option to save the document, the default folder \Documents will be displayed. 
You need to create a folder with the name Motor Cycle Project in the Documents folder and 
then save all parts in this folder. The steps to save this part are given below:

1.    Choose the Save button from the Menu Bar; the Save As dialog box is displayed. 
Browse to the Documents folder and create a new folder with the name Motor Cycle 
Project in it. 

2.   Double-click on the newly created folder and then enter Front Axle as the name of the 
part in the File name edit box. Next, choose the Save button; the document is saved at 
\Documents\Motor Cycle Project.

3.   Close the document by choosing File > Close from the SolidWorks menus. 

CREATING THE DISC PLATE
 Part Description 
In this section, you will create the Disc Plate, as shown in Figure 2-24, by using different feature 
creation tools of SolidWorks. The fi rst feature of the Disc Plate will be created by using the 
Extruded Boss/Base tool. Then, the other features of the Disc Plate will be created by using 
the Extruded Cut, Circular Pattern, and Fill Pattern tools. The dimensions of the Disc Plate 
are shown in Figure 2-25. 

Figure 2-24  The Disc Plate Figure 2-25  Dimensions of the Disc Plate

Starting a New Part Document
1. Choose the New button from the Menu Bar; the New SolidWorks Document dialog box 

is displayed in which the Part button is chosen by default. Choose the OK button; a new 
part document is started.

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om



Creating Axle and Disc Plate                   2-15 

Creating the Base Feature of the Disc Plate
 In this section, you need to create the base feature of the model which is an extruded 

feature.

1. Choose the Extruded Boss/Base button from the Features CommandManager; 
the Extrude PropertyManager is displayed and you are prompted to select the 
sketching plane.

2. Select the Front Plane as the sketching plane from the drawing area; the sketching 
environment is invoked and the selected plane is oriented normal to the view.

3. Choose the Circle button from the Sketch CommandManager; the Circle 
PropertyManager is displayed. Also, the cursor is converted into a circle cursor.

4. Move the circle cursor close to the origin and press the left mouse button when an orange 
circle is displayed.

5. Next, move the cursor toward the right and click when the radius of the circle above the 
circle cursor shows 1.25. 

Figure 2-26  Sketch after drawing the circles

6. Similarly, draw a circle of radius 4.25 units. 
Note that the center points of both the circles 
are at the origin. The sketch after drawing the 
circles should look similar to the one shown in 
Figure 2-26. 

 After drawing the circles, you need to apply 
diameter dimensions to it using the Smart 
Diameter tool.  

7. Choose the Smart Dimension button 
from the Sketch CommandManager; 
the cursor is converted into a 
dimension cursor.

8. Move the dimension cursor to the inner circle; the circle is highlighted. Select the 
highlighted circle; a diameter dimension is attached to the cursor.

9. Move the cursor toward the right and click to place the diameter dimension; the Modify 
dialog box is displayed.

Note
The Modify dialog box will appear automatically only if the Input dimension value check 
box is selected in the System Options - General dialog box. To display the Modify dialog box, 
invoke the System Options - General dialog box by choosing the Options button from the 
Menu Bar and then select the Input dimension value check box in it.
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10. Enter 2.5 as the diameter value in the 
Modify dialog box and then press 
ENTER; the  diameter of the circle gets 
modifi ed to 2.5 inches.

11. Similarly, apply the diameter dimension to the 
outer circle and modify it to 8.5 units, as shown 
in Figure 2-27.

12. Click on the confi rmation corner available 
at the upper right of the drawing area; the 
Boss-Extrude PropertyManager is displayed. 
You will notice that the view is automatically 
changed to the trimetric view and the preview 
of the base feature is displayed in the drawing area. Also, an arrow is displayed in front 
of the sketch, as shown in Figure 2-28.

13. Select the Mid Plane option from the End Condition drop-down list of the Direction 1 
rollout in the Boss-Extrude PropertyManager.

As discussed earlier, the End Condition drop-down list provides the options to defi ne the 
termination point of an extruded feature. The Mid Plane option available in the End Condition 
drop-down list is used to create a feature by extruding a sketch equally in both directions of 
the plane on which the sketch is drawn. 

14. Set 0.3 in the Depth spinner of the Direction 1 rollout in the PropertyManager.

 You have selected the Mid Plane option as the end condition of the feature. Therefore, 
the feature will extrude 0.15 inch toward the front of the sketching plane and 0.15 inch 
toward the back.

15. Choose the OK button ( ) from the Boss-Extrude PropertyManager; the base feature 
is created, as shown in Figure 2-29.

Figure 2-28  Preview of the base feature Figure 2-29  Base feature of the model

Figure 2-27  Sketch after applying the 
diameter dimensions
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Creating the Second Feature
 The second feature of the model is an extrude cut feature. It will be created by using the 

Extruded Cut tool.

1. Choose the Extruded Cut button from the Features CommandManager; the Extrude 
PropertyManager is displayed and you are prompted to select the sketching plane.

2. Select the front planar face of the base feature as the sketching plane; the sketching 
environment is invoked.

3. Choose the Normal To button from the View Orientation fl yout in the View 
(Head-up) toolbar; the current orientation of the feature is changed normal to 
the screen. 

4. Move the cursor over the inner circular edge of the base feature and select it when it is 
highlighted.

5. Choose the Convert Entities button from the Sketch CommandManager; a sketch 
is created by projecting the selected edge into the current sketching plane, refer 
to Figure 2-30. Next, press the ESC Key to exit the tool.

The Convert Entities tool is used to create one or more sketch curves by projecting an edge, 
loop, face, curve, and so on onto the current sketching plane.

Tip. You can select multiple entities to create a sketch by projecting them on the current 
sketching plane. You can also select entities after invoking the Convert Entities tool.

Note
When you create a sketch curve by using the Convert Entities tool, the On Edge and Fixed 
relations are applied automatically to the sketch curve. The On Edge relation is applied between 
the sketch curve created and the selected entity. This causes the sketch curve to get updated if the 
entity is changed. The Fixed relation is applied internally on the endpoints of the sketch curve 
so that the sketch remains in a fully-defi ned state.  

6. Choose the Offset Entities button from the Sketch CommandManager; the 
Offset Entities PropertyManager is displayed. 

The Offset Entities tool is used to draw parallel lines or concentric arcs and circles. You can 
offset the selected entities, edges, loops, and curves. You can also select the parabolic curves, 
ellipses, and elliptical arcs for offset.  

7. Set 1.375 in the Offset Distance spinner of the Parameters rollout in the 
PropertyManager. 

The Offset Distance spinner is used to set the distance to which the selected entity needs to 
be offset.
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Tip. You can also specify the offset distance of the entity by dragging the preview of the 
offset entity in the drawing area.

8. Accept the other default options in the PropertyManager and select the curve from the 
drawing area; the preview of the offset curve is displayed. Also, an arrow is displayed 
in the direction pointing outward. If the direction of arrow is inward then you need to 
reverse the direction of arrow by selecting the Reverse check box from the Offset Entities 
PropertyManager.

9. Choose the OK button ( ) from the PropertyManager; a new sketch entity is created at 
an offset distance of 1.375 from the selected sketch entity, as show in Figure 2-30.

10. Choose the Centerline button from the Line fl yout in the Sketch CommandManager, 
refer to Figure 2-31; the Insert Line PropertyManager is displayed. 

Figure 2-30  Sketch created by using the Convert 
Entities and Offset Entities tools

Figure 2-31  Choosing the Centerline 
button from the Line fl yout

The Centerline tool is used to draw construction lines or centerlines. These lines help in 
drawing sketches but are not considered while converting the sketches into features. 

11. Specify the origin as the start point of the centerline and move the cursor vertically upward. 
You will notice that the symbol of the Vertical relation ( ) is displayed next to the 
cursor.

In SolidWorks, the Horizontal and Vertical 
relations are applied automatically to the 
lines, depending upon the direction of 
movement of the lines. These relations ensure 
that the lines drawn are vertical or horizontal 
and not inclined. 

12. Specify the endpoint of the centerline by 
clicking anywhere outside the inner circle, 
refer to Figure 2-32. Figure 2-32  Sketch after drawing the centerline
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Note
In Figure 2-32, the display of the relation symbol is hidden for the clarity of fi gure. To view/
hide the relations, choose the View Sketch Relations button from the Hide/Show Items fl yout 
in the View (Heads-up) toolbar. This is a toggle button.

13. Choose the Line button from the Sketch CommandManager; the Insert Line 
PropertyManager is displayed. Also, the cursor is replaced with the line cursor. 
You can also invoke the Line tool by pressing the L key. 

The Line tool is used to draw an individual line or a chain of continuous lines. In SolidWorks, 
while drawing continuous lines using the Line tool, you can also draw the tangent or normal 
arcs that originate from the endpoint of the lines. SolidWorks also allows you to draw lines of 
infi nite length using the Line tool.

Tip. You can also draw a line by using the Centerline tool. To do so, choose the Centerline 
tool from the Line fl yout; the Insert Line PropertyManager is displayed. In this 
PropertyManager, clear the For construction check box in the Options rollout. Similarly, 
you can draw a centerline by using the Line tool.

14. Move the line cursor toward the origin and click when an orange circle is displayed at the 
origin; the start point of the line is specifi ed and the Line Properties PropertyManager is 
displayed. However, the options of this PropertyManager are not available at this stage.

15. Move the line cursor such that the line is drawn at an angle of 72-degree from the horizontal 
axis and the symbol of coincident relation is displayed when the line touches the outer 
circle of sketch. This angle can be checked from the Angle spinner in the Parameters 
rollout of the Line Properties PropertyManager.

   
16. Press the left mouse button at this location to specify the endpoint of the line. Note that 

the Line tool is still active and the endpoint of the line drawn is automatically selected as 
the start point of the next line. This is a continuous process and you can draw a chain of 
many continuous lines by specifying points on the screen using the left mouse button.

17. Press the ESC key to exit the Line tool. Alternatively, double-click on the screen or 
right-click to display the shortcut menu and then choose the End chain or Select option 
from it to exit the Line tool.

 After drawing the line, you will mirror it about the vertical centerline using the Mirror 
tool.  

18. Choose the Mirror Entities button from the Sketch CommandManager; the 
Mirror PropertyManager is displayed. 

The Mirror tool is used to create the mirror image of the selected entities. Note that when you 
create a mirror entity, SolidWorks applies the symmetric relation between the selected entities. 
Also, if you change an existing entity, its mirror entity will also change automatically.
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19. Select the line drawn in Step 16 from the drawing area; the line is highlighted in blue and 
its name is displayed in the Entities to mirror selection area of the PropertyManager.

The Entities to mirror selection area of the PropertyManager displays the name of the entities 
to be selected for mirroring.

20. Click on the Mirror about selection area of the PropertyManager to activate its selection 
mode.

The Mirror about selection area of the PropertyManager allows you to select an entity that 
will be used as a mirroring line.

21. Select the vertical centerline from the drawing area as a mirroring line; the preview of the 
mirror entity is displayed in the drawing area. Make sure the Copy check box is selected 
in the PropertyManager.

The Copy check box is used to remove or retain the selected parent entities while mirroring 
them. For example, if you clear this check box, then while mirroring the sketched entities, the 
selected parent entities will be removed and only the mirror image will be retained.

Figure 2-33  Sketch after mirroring the line

22. Choose the OK button ( ) from the Mirror 
PropertyManager; the mirror image of the 
selected entity is created, as shown in 
Figure 2-33.

 Next, you need to trim the unwanted entities 
in a sketch using the Trim Entities tool. 

23. Choose the Trim Entities button 
from the Sketch CommandManager; 
the Trim PropertyManager  is 
displayed.

The Trim Entities tool is used to trim the unwanted entities from a sketch. These entities can 
be lines, arcs, ellipses, parabolas, circles, splines, or centerlines.

24. Choose the Trim to closest button from the Options rollout of the Trim 
PropertyManager; the cursor is replaced by the trim cursor. 

The Trim to closest button is used to trim a selected entity at the intersection which is closest 
to it. 

25. Move the trim cursor closer to the entity inside the smallest circle of the sketch and click 
when the entity is highlighted; the entity is trimmed. Next, move the trim cursor closer 
to the next entity that is inside the smallest circle of the sketch and click when the entity 
is highlighted; the entity is trimmed, refer to Figure 2-34.
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26.  Similarly, trim other entities of the sketch and press the ESC key to exit the Trim Entities 
tool. Figure 2-35 shows the resultant sketch after trimming all unwanted entities from the 
sketch.

Figure 2-34  Sketch after trimming the entities Figure 2-35  Resultant sketch

27. Apply angular dimensions between the inclined lines and the inclined line and centerline 
by using the Smart Dimension tool, as shown in Figure 2-36.

28. Click on the confi rmation corner; the Cut-Extrude PropertyManager and the 
preview of the cut feature are displayed. 

29. Select the Up To Next option from the End Condition drop-down list of the Direction 1 
rollout in the Cut-Extrude PropertyManager.

As discussed earlier, the End Condition drop-down list is used to defi ne the termination point 
of an extruded feature. The Up To Next option in this drop-down list is used to extrude a 
sketch from the sketching plane to the next surface that intersects the feature. 

Note
The Up To Next option will be available in the End Condition drop-down list only after the 
base feature has been created.

30. Choose the OK button ( ) from the Cut-Extrude PropertyManager; the cut extrude 
feature is created. Next, change the current orientation of the model to isometric by 
choosing the Isometric button from the View Orientation fl yout. Figure 2-37 shows the 
isometric view of the model after creating the cut extruded feature.
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Figure 2-36  Sketch after applying dimensions Figure 2-37  Isometric view of the model

Creating the Extrude Cut Feature
 Next, you need to create a hole at the base of the model. This hole will be created as an 

extruded cut feature. First, you need to draw the sketch of this feature on the front circular 
face of the base feature and then convert the sketch drawn into an extruded cut feature 
by using the Extruded Cut tool. 

1. Select the front circular face of the base feature and keep the cursor intact for sometime; 
a pop-up toolbar is displayed. Choose the Sketch button from the pop-up toolbar; the 
sketching environment is invoked.

2. Orient the current view normal to the viewing direction by choosing the Normal 
To button from the View Orientation fl yout.

3. Draw a circle of diameter 3.5 inches with its center at the origin by using the Circle tool. 
Also, apply the diameter dimension to the circle using the Smart Dimension tool. Next, 
press the ESC key to exit the current tool.

4. Select the circle from the drawing area and keep the cursor intact for sometime; a pop-up 
toolbar and the Circle PropertyManager are displayed.  

5. Choose the Construction Geometry button from the pop-up toolbar; the selected 
circle is converted into a construction circle, refer to Figure 2-38. Alternatively, 
you can select the For construction check box from the Options rollout of the 
Circle PropertyManager to draw a construction circle. 

6. Draw the remaining entities of the sketch. Next, apply dimensions to it by using the tools 
in the Sketch CommandManager, refer to Figure 2-39. 
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Figure 2-38  Construction circle Figure 2-39  Sketch of the cut feature

7. Choose the Features tab from the CommandManager; the Features CommandManager 
is displayed.  

8. Choose the Extruded Cut button from the Features CommandManager; the Cut-Extrude 
PropertyManager is displayed.

9. Change the current view to isometric by choosing the Isometric button from the View 
Orientation fl yout.

10. Select the Up To Next option from the End Condition drop-down list of the Direction 1 
rollout in the Cut-Extrude PropertyManager.

11. Choose the OK button ( ) from the Cut-Extrude PropertyManager. The isometric view 
of the model after creating the extruded cut feature is shown in Figure 2-40.

   Figure 2-40  Sketch after creating the cut feature

Patterning the Features
 After creating the cut features, you need to pattern them using the Circular pattern 

tool. 
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Figure 2-41  The Linear Pattern fl yout

1. Choose the Linear Pattern button from the Features 
CommandManager; the Linear Pattern fl yout is 
displayed, refer to Figure 2-41. 

2. Choose the Circular Pattern button from the Linear 
Pattern fl yout, refer to Figure 2-41; the Circular 
Pattern PropertyManager is displayed.

The Circular Pattern tool is used to pattern a feature, 
face, or body in a circular manner.

3. Click on the (+) sign on the left of the 
FeatureManager design tree, which is now displayed on the left in the drawing area; the 
tree view expands. The three default planes and the list of features created in this part 
fi le are now visible in this tree view.

The FeatureManager design tree stores and displays all features in a hierarchical manner. 
You can select any feature of a model or an assembly from the FeatureManager design tree 
and apply different operations on the selected feature.

Note
In the Features to Pattern rollout of the Circular Pattern PropertyManager, the Features 
to Pattern selection area remains activated by default. As a result, you can select features from 
the drawing area or from the FeatureManager design tree to create a circular pattern.

4. Select the Cut-Extrude1 and Cut-Extrude2 features from the FeatureManager design 
tree; the names of the selected features are displayed in the Features to Pattern selection 
area of the PropertyManager.

5. Click once in the Pattern Axis selection area of the Parameters rollout in the Circular 
Pattern PropertyManager to activate it.

The Pattern Axis selection area is used to specify the pattern axis. You can select a circular 
edge or an axis for defi ning the pattern axis. If you are creating a circular pattern on a circular 
feature then you can select the circular edge of the feature as the pattern axis. On doing so, 
the center of the circular feature is selected as the pattern axis.

6. Select the circular edge of the base feature; the preview of the circular pattern of the 
selected cut features with default values is displayed in the drawing area.

7. Set 5 in the Number of Instances spinner in the Parameters rollout of the PropertyManager. 
Also, make sure the Equal spacing check box is selected and the value of the Angle spinner is 
set to 360-degree in the Parameters rollout of the Circular Pattern PropertyManager.

The Number of Instances spinner in the Parameters rollout of the PropertyManager is used 
to specify the number of instances in a pattern and the Equal spacing check box is used to 
specify equal or user-defi ned angular spacing between the instances. 
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Note
When the Equal spacing check box is cleared, you need to specify the incremental angle between 
the instances in the Angle spinner. However, if it is selected, SolidWorks automatically calculates 
and determines the angular spacing between the instances.

8. Choose the OK button ( ) from the Circular Pattern PropertyManager; the circular 
pattern of the selected features is created. Next, change the current view of the model to 
isometric by choosing the Isometric button from the View Orientation fl yout. The 
isometric view of the model after patterning the cut features is shown in Figure 2-42. 

   

Figure 2-42  Model after patterning the cut features

Creating the Fill Pattern of the Predefi ned Hole
 Next, you will create a fi ll pattern of the predefi ned holes by using the Fill Pattern tool. 

Figure 2-43  The Linear Pattern fl yout

1. Choose the Fill Pattern button from the Linear Pattern 
fl yout in the Features CommandManager, refer to 
Figure 2-43; the Fill Pattern PropertyManager is 
displayed. 

The Fill Pattern tool is used to fi ll a specifi ed area with 
the pattern of features, faces, or predefi ned holes. The 
area to be fi lled by the pattern of features or holes can 
be a sketched entity, a face, or a coplanar face.

2. Select the front circular face of the model from the 
drawing area as the area to be fi lled; the selected 
face is highlighted and the name of the selected 
face is displayed in the selection area of the Fill Boundary rollout of the Fill Pattern 
PropertyManager.   

3. Expand the Features to Pattern rollout of the PropertyManager by clicking on the down 
arrow located on its right, if it is not expanded. 

The Features to Pattern rollout of the PropertyManager is used to defi ne whether you want 
to create a fi ll pattern of features or predefi ned holes. By default, the Selected features radio 
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button is selected in this rollout; as a result, you can select features from the drawing area or 
from the FeatureManager design tree to create a fi ll pattern. To create the fi ll pattern of the 
predefi ned holes, you need to select the Create seed cut radio button from this rollout.

4. Select the Create seed cut radio button from the Features to Pattern rollout of the 
PropertyManager to create a pattern of the predefi ned holes. On selecting this radio 
button, the Circle, Square, Diamond, and Polygon buttons below the radio button are 
enabled. Also, the preview of the pattern is displayed in the drawing area.   

Note
By default, the Circle button is chosen in  the Features to Pattern rollout; therefore, the preview 
of the circular hole pattern is displayed in the drawing area.

Tip. To create a square, diamond, or polygon hole patterns, you need to select the radio 
button corresponding to the required option.

5. Set 0.35 in the Diameter spinner of the Features to Pattern rollout of the 
PropertyManager.

 Next, you need to specify the parameters for the pattern layout in the Pattern Layout 
rollout of the Fill Pattern PropertyManager. 

The buttons such as Perforation, Circular, Square, and Polygon available in the Pattern 
Layout rollout of the PropertyManager are used to create the perforated, circular, square, 
and polygon patterns, respectively. By default, the Perforation button is chosen by default in 
this rollout.

6. Choose the Circular button from the Pattern Layout rollout of the PropertyManager 
to create a circular shape pattern. 

7. Set 3.75 in the Loop Spacing spinner of the Pattern Layout rollout.

8. Select the Instances per loop radio button to defi ne the instances of the loop and then 
set 25 in the Number of Instances spinner.

Note
In the preview of the fi ll pattern, the seed feature is located at the center of the fi ll boundary face. 
For this tutorial, you can accept this default position. However, you can specify the user-defi ned 
position for the seed feature by using the Vertex or Sketch Point selection area of the Features 
to Pattern rollout in the Fill Pattern PropertyManager. To do so, fi rst you need to activate 
this selection area by clicking on it. Next, you need to select a vertex or sketch point from the 
drawing area and defi ne the position of the seed feature.

9. Choose the OK button from the Fill Pattern PropertyManager; the fi ll pattern of the 
predefi ned circular holes is created, as shown in Figure 2-44.
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Figure 2-44  Model after creating the fi ll pattern feature

Creating the Fillet Feature
 Next, you need to apply the fi llet to the model by using the Fillet tool. In SolidWorks, a 

fi llet is created as a placed feature.     

1. Choose the Fillet button from the Features CommandManager; the Fillet 
PropertyManager is displayed and you are prompted to select edges, faces, 
features, or loops to create fi llet. Note that if the FilletXpert PropertyManager 
is displayed, you need to choose the Manual button from it to display the Fillet 
PropertyManager.

The Fillet tool is used to remove sharp corners by adding or removing material from the 
corners based on the edge reference selected. In SolidWorks, you can add fi llets as a placed 
feature to the model using the Manual or FilletXpert option. The Manual option is used to 
fi llet an internal or external face or edge of a model. Whereas, the FilletXpert option is used 
to create a single fi llet or multiple fi llets and change the existing constant fi llets. 

2. Make sure the Constant radius radio button is selected in the Fillet Type rollout of the 
PropertyManager. 

The Fillet Type rollout of the PropertyManager has radio buttons that can be used to create 
different types of fi llets. By default, the Constant radius radio button is selected and is used 
to create a fi llet of a constant radius along the selected entity.  You can also create a variable 
radius fi llet, face fi llet, or full round fi llet by selecting their respective radio buttons from the 
Fillet Type rollout of the PropertyManager.

3. Select the required edges of the model from the drawing area to create fi llets; the preview 
of the fi llet feature with the default radius value is displayed in the drawing area, refer to 
Figure 2-45. Also, a callout is displayed attached to the preview of the fi llet with its current 
radius value. The names of the selected edges of the model are displayed in the selection 
area of the Items To Fillet rollout of the Fillet PropertyManager.

4.   Set 0.25 in the Radius spinner of the Items To Fillet rollout and then choose the OK 
button from the Fillet PropertyManager. The fi nal model after applying the fi llet feature 
is shown in Figure 2-46.
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Figure 2-45  Preview of the fi llet feature Figure 2-46  Final model of the Disc plate

Saving the Model
 After completing the model, you need to save it in the Motor Cycle Project folder. 

1.    Invoke the Save As dialog box by choosing the Save button from the Menu Bar 
and browse to the Motor Cycle Project folder.

2. Enter Disc Plate as the name of the model in the File name edit box and then choose 
the Save button from the dialog box; the document is saved at \Documents\Motor Cycle 
Project. 

3.    Close the document by choosing File > Close from the SolidWorks menus.

Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:

1. Most of the products designed by using SolidWorks are a combination of __________, 
__________, and __________ features.  

2. The __________ feature is a feature that is created fi rst while creating a model in the Part 
environment.

3. The __________ planes are called datum planes.

4. The __________ tool is used to add the material defi ned by a sketch.

5. The __________ drop-down list provides options to defi ne the termination point of an 
extruded feature.

6. A black colored sketch indicates that it is a fully-defi ned sketch. (T/F)
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7. You can specify the depth of extrusion by dragging the arrow located in the preview of a 
model. (T/F)

8. When you create a sketch curve by using the Convert Entities tool, the __________ and 
__________ relations are automatically applied to it.

9. You cannot specify the offset distance of an entity by dragging its preview in the drawing 
area. (T/F)

10. The Constant radius radio button is used to create a fi llet of constant radius. (T/F)

Review Questions
Answer the following questions: 

1. The __________ button in the Hide/Show Items fl yout is used to hide or show the relations 
applied to the sketch.

2. The __________ tool is used to draw parallel lines or concentric arcs and circles.

3. The __________ tool is used to create the mirror images of the selected entities.

4. The __________ tool is used to pattern a feature, face, or body in a circular manner.

5. The __________ tool is used to fi ll a specifi ed area with the pattern of features, faces, or 
predefi ned holes.

6. The Modify dialog box appears automatically only when the Input dimension value check 
box is selected in the Options dialog box. (T/F)

7. Which rollout of the Boss-Extrude PropertyManager is used to specify the end condition 
for extruding a sketch in the fi rst direction?

  (a) Direction    (b) Direction 2
  (c) Direction 1    (d) From

8. Which of the following radio buttons is used to create a fi ll pattern of predefi ned holes?

  (a) Selected features   (b) Create seed cut
  (c) Instances per loop   (d) None of these

9. In SolidWorks, you can draw a regular polygon with infi nite number of sides. (T/F)

10. The Number of  Instances  spinner in the Parameters  rol lout  of  the 
Circular Pattern PropertyManager is used to specify the number of instances in a 
pattern. (T/F)
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2-30             Learning SolidWorks 2011: A Project Based Approach

EXERCISE
 Exercise
In this exercise, you will create a rear axle, as shown in Figure 2-47. The features of this Axle 
will be created by using the Extruded Boss/Base tool. You will create cosmetic threads with 
shaded display by using the Ansi Inch of Machine Threads type. The views and dimensions 
of the axle are given in Figure 2-48. All dimensions are in inches. After completing the 
model, save it with the name Rear Axle at the location \Documents\Motor Cycle Project.  
         (Expected time: 15 min)
          

Figure 2-47  Rear axle

Answers to Self-Evaluation Test
1. sketch, placed, derived, 2. base, 3. default, 4. Extruded Boss/Base, 5. End Condition, 6. T, 
7. T, 8. On Edge, Fixed, 9. F, 10. T

Figure 2-48  Views and dimensions of the rear axle
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